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RAWC Installation and User Guide v3.0  
 
 

1. Introduction 
When validating VMware Horizon™ and VMware Horizon Cloud™ designs it is important to simulate 
real world usage as closely as possible.  The Desktop Reference Architecture Workload Simulator 
(RAWC) can be used to simulate a user workload in a typical Microsoft Windows® desktop or 

Microsoft Windows® Remote Desktop Services (RDS) environment. 

Desktop RAWC runs on each desktop virtual machine (VM) on one or more VMware ESX™ hosts.  
Desktop RAWC can also run on Microsoft Windows Server 2012R2, 2016 or 2019 host with Remote 
Desktop Services installed.  Each target desktop VM or RDS host VM is equipped to run a RAWC 
workload that simulates typical user behavior, running an application set commonly used across a 
broad array of desktop environments.  The workload has a set of randomly executed functions that 
perform operations on a variety of applications. 

Each test is configured using the Desktop RAWC UI.  The UI enables you to save and retrieve test 
parameters and create log folders.  You can use the UI to increase the load or adjust the user 
behavior, such as the number of words per minute that are typed and the delay between applications 
being launched. 

The workload configuration typically used includes Microsoft Word, Excel, PowerPoint, Outlook, 
Internet Explorer, Windows Media Player, Adobe Acrobat and 7-Zip.  Additional applications include 
Chrome Firefox, Notepad, Photos and YouTube.  During the execution of the workload, multiple 
applications are opened at the same time and windows are minimized and maximized as the workload 
progresses, randomly switching between each application.  Individual application operations that are 
randomly performed can include: 

 Microsoft Word – Create, minimize, maximize, close, write text, save modifications 

 Microsoft Word (Random) – Create, minimize, maximize, close, write random words/numbers, 
save modifications 

 Microsoft Excel – Create, minimize, maximize, close, write random numbers, insert/delete 
columns/rows, copy/paste formulas, save modifications 

 Microsoft PowerPoint – Open, minimize, maximize, close, conduct a slide show presentation 

 Microsoft Outlook – Open, minimize, maximize, close, create/send emails, setup user account for 
both Sendmail and Gmail 

 Internet Explorer – Open, minimize maximize, close, browse page 

 Windows Media Player – Open, close, view a video 

 Adobe Acrobat Reader (Browse) – Open, minimize, maximize, close, browse random pages in PDF 
document 

 Adobe Acrobat Reader (Scroll) – Open, minimize, maximize, close, select speed and time to scroll a 
PDF document 

 Chrome – Open, minimize, maximize, close, browse page 

 Firefox – Open, minimize, maximize, close, browse a specified URL 

 File Copy – Copy files from the RAWC Controller to the User’s Documents directory on the desktop 
VM 
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 Notepad – Open, minimize, maximize, close, create pdf file and print 

 Photos – Open, close, several photos 

 Sleep – Sleep test for a specified period of time 

 YouTube video – Open, close, view a specific YouTube video 

 7-Zip – Open, close, compress large files 

 

There are several videos that have been created that will provide you with an overview RAWC 
including installation, configuring a test, running a test and charting the results.  You can find these 
videos on the RAWC Community page. 

 https://communities.vmware.com/community/vmtn/rawc 

 

Depending upon the size of the test, you may use multiple ESX hosts and session launcher VMs, and as 
many target desktop VMs or RDS Session Host VMs as you want to test.  There is no scale limitation in 
RAWC. 

Figure 1 illustrates the Desktop RAWC architecture used with VMware Horizon 

 
 

 

or Target RDS Host VMs 
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1.1 Requirements 
VMware Infrastructure or VMware vSphere™ should be installed and operational in a lab (non-
production environment. 

 

1.1.1 Email Server Virtual Machine 

If you do not want to run the Microsoft Outlook workload (Sendmail) as part of the test, you can ignore 
this section. 

If you want to run the Microsoft Outlook workload (Gmail), simply set up an account in Gmail.  The Email 
Server Virtual Machine is not required for running Outlook with a Gmail account. 

No changes were made to the Email Server Virtual Machine from the prior Desktop RAWC version. 

The following software is required for the provided Email Server virtual machine that supports running 
the Microsoft Outlook workload: 

 VMware vSphere 5.0 (or later), or VMware Virtual Center/vCenter Server 5.0 (or later)    

 15GB hard disk 

 1GB memory (more if you are running a large number of virtual desktops) 

You do not have to use the Email Server that is provided with Desktop RAWC—you can supply your own 
Microsoft Exchange server. 

 

1.1.2 Desktop RAWC Controller  

The following is required for the Desktop RAWC Controller: 

o Microsoft Windows Server 2012R2 or 2016 or 2019 64-bit OS is required for the RAWC 
Controller machine that hosts the Desktop RAWC UI and shared network folders for the log files.  
The RAWC Controller can be a physical or virtual machine. 

 

1.1.3 Session Launcher VMs  

The Desktop RAWC Session Launcher has been updated to support new features in the Desktop RAWC 
Workload. 

Each session launcher VM can support up to 50 sessions.   

Note:  There have been installations that have run up to 100 sessions per launcher successfully.  If you 
are short on resources, you can try launching more than 50 sessions. 

Requirements: 

o Windows 10 64-bit or Windows Server 2016 64-bit OS 

o VMware Horizon Client 5.0 or later         

 

1.1.4 Target Desktop VMs 

The Desktop RAWC Workload Simulator has been updated with new features and a Test Locations 
script.  Create a target desktop VM master image and then clone the number of target desktop VMs you 
want to use in your test. 

The minimum required target desktop VM configuration is:       
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o 2 vCPU 

o 3 GB memory 

o 40 GB disk space 

o Windows 10 (64-bit) OS            

o A Horizon Agent 7.8 or later must be installed on each target desktop VM   

o If Microsoft Outlook is part of the workload, use a persistent desktop pool so that users will get 
the same desktop for every test.  If that is not possible, then run Outlook Setup or Gmail Setup 
in every test. 

 

1.1.5 Applications 

A set of applications comprise the workload that runs on each target desktop VM or RDS Host.  You can 
select which applications to use for a test from the Desktop RAWC UI. 

The customer must supply software, licenses and video files for each of the following applications they 
want to use in a test: 

o Microsoft Office 2016 (Word, Excel, PowerPoint, Outlook) 

7-Zip is provided and installs automatically when Desktop RAWC is installed. 

Some applications must be downloaded from vendor sites and installed or copied to particular locations.  
Gather the following applications beforehand so that they will be available when you configure Desktop 
RAWC: 

o Adobe Acrobat Reader DC 

o Video file (.wmv for Windows Media Player workload) 

o YouTube URL 

o URL for Firefox 

o Large files (File Copy workload) 

 

1.1.5.1 Adobe Acrobat Reader DC 

RAWC 3.0 uses Adobe Acrobat Reader DC to browse and scroll PDF documents. 

 

1.1.5.2 Video File 

RAWC 3.0 allows you to specify the video file you want to use.  Make sure that suffix of the file is .wmv.  

 

1.1.5.3 YouTube  

RAWC 3.0 allows you to specify the URL of the YouTube video you want to use.  

 

1.1.5.4 File Copy 

Locate several large files (docx, pdf, wmv, txt, etc.) to be used by the File Copy workload. 
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1.2 What’s new in RAWC 3.0  

New Applications and Features 
 Browsers:  Chrome and Firefox 

 Applications:  Notepad, Photos, YouTube, Sleep and File Copy 

 Feature:  Support for RDS Sessions on either a Windows Server 2012R2, 2016 or 2019 64 OS host. 

Updated Workloads and Features 
 The application open and close times have been split into two separate log files for ease of viewing 

and charting.   

 Microsoft Office 2016 (Outlook, Word, Excel and PowerPoint) is supported.  No other versions of 
Microsoft Office are supported at this time.   

 VMware Desktop RAWC 3.0 supports Adobe Acrobat Reader DC. 

 VMware Desktop RAWC 3.0 supports the use of a Gmail account in the Outlook workload, so that no 
additional email server is required.  

Features Removed 
 VMware Desktop RAWC Group code (Active Directory enabled) has been removed. 

 The Java workload has been removed due to changes in licensing. 

 

1.3 Installation Files 
The following Desktop RAWC files are provided from the RAWC Community Website.  
https://communities.vmware.com/community/vmtn/rawc 

File Name Description 

DesktopRAWCSetup_3.0.zip Contains Desktop RAWC 3.0 executables and 
workload files 

RAWC-EmailServer-VMX.zip Contains the Email Server virtual machine (use 
this file for any version of Desktop RAWC) 

 

1.4 Support 
Desktop RAWC 3.0 has limited support.  For problems, enhancement requests or feedback send email to 
rawc-support@vmware.com. 

Include a full description of the problem.  Also, zip up and send to support the log files from the network 
shared folders Log_Folders and SessionLauncher_Share.  Only the log files are needed.  If 
input files in the network shared folders are also needed to troubleshoot a problem, scrub them first so 
that no customer proprietary information such as passwords are included. 
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2 Installing and Configuring Desktop RAWC  
Perform all installation and configuration tasks as Administrator. 

2.1  Workflow 
Figure 2 illustrates the Desktop RAWC installation workflow, along with requirements and high-level 
tasks. 

 

Figure 2 Desktop RAWC Installation Workflow 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

If you are using Outlook, you can install the Email Server virtual machine before or after installing the 
Desktop RAWC Controller, but it should be set up before creating the target desktop VM master image.  
This enables you to include the address of the Email Server in the target desktop VM master image. 

The Desktop RAWC Controller must be set up before creating target desktop VMs, RDS Session Host 
VMs and Session Launcher VMs.  

Install Desktop RAWC Controller 
Requires:  Windows Server 2012 R2 or 2016 or 2019 64-bit OS  
Tasks:  Create shared network folders, install Desktop RAWC UI, create workload 
configuration files, create session launcher input files 

Install Email Server Virtual Machine (if using Outlook) 
Requires:  VMware vSphere 5.0 (or higher) or vCenter 5.0 (or higher) 
Tasks:  Upload to vSphere or VirtualCenter/vCenter, power on, configure static IP 
address, DNS, gateway, create users for email workload 

Create and Set Up Target Desktop VM Master 
Requires:  Windows 10 64-bit OS  
Tasks:  Install RAWC Desktop Workload software, map network drive, install/set 
up applications, install a Horizon Agent 
or 
Create and Set Up RDS Session Host VM Master 
Requires:  Windows Server 2012R2 or 2016 or 2019 64-bit OS  
Tasks:  Install RAWC Desktop Workload software, map network drive, install/set 
up applications, install a Horizon Agent 
 

Create Session Launcher VM 
Requires:  Windows 10 64-bit or Windows Server 2016 64-bit OS 
Tasks:  Install RAWC Session Launcher software, map network drive, install a 
Horizon Client 

Optional:  Installation of the 
Email Server VM is only 
required if you use Outlook.  
Note:  You can use your own 
Microsoft Exchange Server or 
Gmail account. 

Clone additional Target 
desktop VMs from the 
master image or 
clone additional RDS Session 
Host VMs. 

Clone additional session 
launcher VMs if needed. 



9 

 

 

2.2  Setting Up the Environment 
Set up a VMware Infrastructure including VMware vSphere on compatible hardware in a lab (non-
production) environment. 

 

2.3  Creating a RAWC Controller and Shared Network Folders 
Desktop RAWC requires a Windows Server 2012R2 or 2016 or 2019 64-bit Operating System with 
VMware Tools installed. 

Desktop RAWC requires two shared network folders: 

 Log_Folder – Workload input files are located in this folder so that they are available to the 
target desktop VMs. 

 SessionLauncher_Share – Input files needed by the session launcher VMs are located in 
this folder, and session launcher VMs write log files to this folder. 

To create the RAWC Controller and shared network folders 

1. Create a Microsoft Windows 2012R2 or 2016 or 2019 Server VM (or install a physical machine to be 
the RAWC Controller). 

1.1. Configure the VM with: 4vCPU, 16 GB Memory, 300 GB Disk or similar configuration. 

 Select the Windows Server Datacenter (Server with a GUI) or (Desktop Experience) OS 
version. 

1.2. Install VMware Tools. 

1.3. Join to the Domain. 

1.4. Login as your ‘domain\administrator.’ 

 License the Operating System software. 

 Open the Control Panel application, set the following options: 

a. Turn off all Firewalls 
b. Set the Power Options: 

i. Turn off the display – set to ‘Never’ 

ii. Put the computer to sleep – set to ‘Never’ 

2. Create Log_Folder under the root drive on the RAWC Controller VM.  For example, 
C:\Log_Folder.  Select the folder. 

2.1. Select File > Properties. 

2.2. Click the Sharing tab. 

2.3. Click the Share… button. 

2.4. Enter Everyone in the input box and click the Add button. 

2.5. Select the Permission Level and make it Read/Write. 

2.6. Click the Share button. 

2.7. Click the Done button. 

2.8. Click the Security tab. 
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2.9. Verify permissions for the Everyone group is set to Full Control. 

2.10. Click the Close button. 

3. Repeat Step 2 to create SessionLauncher_Share  folder.  

4. Set the Display Resolution on the RAWC Controller VM:  1280 x 768. 

 

2.4  Downloading and Installing the RAWC Installation Package 
Before downloading the Desktop RAWC installation package and running the installer, set up the RAWC 
Controller, see section 2.3 above. 

Download the Desktop RAWC installation package from the RAWC Community webpage 
https://communities.vmware.com/community/vmtn/rawc and install it on the RAWC Controller. 

To install Desktop RAWC 

1. Download the Desktop RAWC installation package, DesktopRawcSetup_3.0.zip. 

2. On the RAWC Controller, unzip the installation package. 

3. Run DesktopRawcControllerSetup.msi. 

4. In the EULA dialog box, select I agree, and click Next. 

5. Browse to select the installation folder or accept the default. 

6. Select Everyone to specify who should have access to Desktop RAWC and click Next. 

7. Click Next to start the installation. 

8. When the installation is complete, click Close to exit. 

9. Place the DesktopRawcWorkloadSetup.msi file in the Log_Folder folder. 

10. Place the DesktopSessionLauncherSetup.msi file in the SessionLauncher_Share 
folder. 

 

2.5  Downloading and Installing the Email Server Package 
If you are going to use the Microsoft Outlook workload for the test you need an email server.  You can 
use the email server provided with Desktop RAWC, or use your own Microsoft Exchange server.  If you 
do not want to use the Outlook workload you can skip this section. 

The Email Server virtual machine is comprised of the following software: 

 CentOS operating system 

 Dovecot 

 Sendmail 

2.5.1 Downloading and Installing the Email Server 

To install the Desktop RAWC Email Server 

1. Download the Desktop RAWC installation package, RAWC-Emailserver-VMX.zip. 

2. Use VMware vCenter Convertor 5.x to install the Email Server on vCenter 5.0, or ESX 5.0 (or later).  If 
you do not have VMware vCenter Converter, you can download it from the VMware support and 
Downloads Web page at 
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https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_
vcenter_converter_standalone/5_5 

VMware Converter is used to install the Email Server virtual machine because it is distributed in VMX 
format.  Alternatively, you can copy the virtual machine files to a location accessible from an ESX host 
and add the virtual machine from a VI or vSphere Client as follows: 

To register the controller appliance on an ESX 5.0 or later 

1. From the VI Client or vSphere Client, select the desired ESX host. 

2. Select the Configuration tab. 

3. Under Hardware, click Storage. 

4. Double-click the file system where you placed the virtual machine files and navigate to the directory 
where you placed the virtual machine files. 

5. Right-click the .vmx file 

6. Select Add to Inventory, and follow the instructions to add the virtual machine to the VI Client 
inventory. 

2.5.2 Configuring the Email Server 

Prerequisites: 

 A static IP address. 

 A valid fully-qualified domain name. 

To configure the Email Server 

1. Boot the Desktop RAWC Email Server virtual machine. 

2. Use VirtualCenter/vCenter to access the console of the Email Server virtual machine and log in to 
the appliance. 

Login: root 

Password: vmware 

3. Install VMware Tools from the menu or from the command-line: 

a. Click VM >Guest > Install/Upgrade VMware Tools. 

b. From the virtual machine command-line: 

mkdir /mnt/vmware-tools 

mount /dev/cdrom /mnt/vmware-tools 

cd /mnt/vmware-tools 

cp /mnt/vmware-tools/VMware-Tools*.tar.gz /tmp 

cd /tmp 

tar zxvf VMware-Tools*.tar.gz 

cd vmware-tools-distrib 

./vmware-install.pl   (follow the prompts) 

vmware-config-tools.pl   (follow the prompts) 

Reboot the virtual machine after the installation completes. 

4. Verify that the VMware Tools Suite installed correctly: 
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a. In the VI Client or vSphere Client, select the virtual machine. 

b. On the right-hand pane, select the Summary tab 

c. Confirm that VMware Tools shows a status of OK. If it shows any other status, reinstall VMware 
Tools. 

5. Log in to the appliance again. 

6. Change directory to   /root/rawc 

7. Set the static IP address and the corresponding settings by running the command: 

python ./config_appliance.pyc -i <ipaddr> -m <netmask> -g <gateway> -d 

<hostname.full-domainname> -n <dnsip1> [,<dnsip2>, ...] 

Replace <ipaddr>, <netmask>, <gateway>, <full-domainname>, <dnsip1>, and (optionally) additional 
DNS addresses with appropriate values, including the static IP address and the 
hostname.domainname. For example: 
python ./config_appliance.pyc -i 10.17.50.171 -m 255.255.254.0 –g 10.17.50.107 -d 

rawc-email-server.vdi-smtp2.rawc.local -n 10.17.50.107,10.10.18.1,10.20.10.1 

Note:  To make sure that all target desktop VMs will know the address of the Email Server, on the target 
desktop master VM WIN10-VM-00, edit C:\windows\system32\drivers\etc\hosts 
and add a line with the domain name and IP address of the email server. For example, vdi-
smtp2.rawc. local 10.17.50.171. 

2.5.3 Creating User Accounts on the Email Server 

The users created by the following procedure are used by the Email Server for the Outlook email 
workload.  (These are not the users that you later need to create in Active Directory which are used to 
log in to the target desktop VMs.) 

The Outlook function in Desktop RAWC uses “guest” plus the third and fourth segments of the IP 
address as the user name when sending an email.  For example, a VM with an IP address of 
69.110.17.180 will have a user name of:  guest17180. 

Because of the way the useraddition.sh script generates user accounts you have to edit and run 
the script multiple times to generate the correct set of users if the range of IP addresses spans subnets, 
or if the final octet of the low value is two digits and the final octet of the high value is three digits. 

To create user accounts on the Email Server 

1. Determine the range of IP addresses for all VMs that will be used for the test.  For this example, we 
use a range from 10.129.1.97 through 10.129.1.109.  Because the final octet changes from two to 
three digits, you have to edit and run the script twice to generate the complete set of email user 
accounts. 

2. From the Email Server virtual machine command-line: 

cd /root/rawc  

3. Edit the useraddition.sh script: 

a. On the line that contains start = 2090, change the number to the lowest number in the ip 
address range.  For example, if 10.129.1.97 is the lowest IP address in the IP address range, 
concatenate the values in the third and fourth segments of the IP address, and enter 197. 

b. On the line that contains end = 2103, change the number to the highest two-digit number in 
the final octet of the IP address range.  For example, if 10.129.1.109 is the highest IP address in 
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the IP address range, enter 199.  Note that 99 is the highest two digit number in the range and 
when the third and fourth segments are concatenated, 199 is the result. 

c. Save the file. 

d. Run useraddition.sh to generate the first set of users. 

e. Edit the useraddition.sh script a second time: 

f. On the line that contain start = 197, change the number to the lowest number in the second 
part of the IP address range.  For example, if 10.129.1.97 is the lowest IP address, concatenate 
the values in the third and fourth segments of the IP address, and enter 1100.  Note that 100 is 
the lowest three digit number in the range when the third and fourth segments are 
concatenated, 1100 is the result. 

g. On the line that contains end = 199, change the number to the highest number in the IP 
address range.  For example, if 10.129.1.109 is the highest IP address in the IP address range, 
enter 1109.  Note that 109 it the highest three digit number in the range and when the third 
and fourth segments are concatenated, 1109 is the result. 

h. Save the file. 

i. Run useraddition.sh to generate the second setup of users. 

Note: Though you do not normally need it, the password is defined within the useraddition.sh script.  
Default is abc123. 

2.5.3.1 Example Using Multiple subnets and a Two- to Three-Digit Final Octet Range 

Your target desktop VMs have address ranges 10.129.132.50 – 10.129.132.249 and 10.129.133.50 – 
10.129.133.249.  Because of the way useraddition.sh generates user accounts, giving a start value 
of 13250 and an end value of 133249 would generate thousands of guest users – not the desired results! 

To properly generate guest users in this case you need to edit and run useraddition.sh four 
times, once for each of the start and end values shown in the following table. 

IP Address Range Start and End Value Generated Guests 

10.129.132.50 – 10.129.132.99 Start=13250 

End = 13299 

This generates users guest13250 – 
guest13299 

10.129.132.100 – 10.129.132.249 Start= 132100 

End=132249 

This generates users guest132100 – 
guest132249 

10.129.133.50 – 10.129.133.99 Start=13350 

End=13399 

This generates users guest13350 – 
guest13399 

10.129.133.100 – 10.129.133.249 Start=133100 

End=133249 

This generates users guest133100 – 
guest133249 

 

2.5.4 Next Step  

You still need to run Outlook Setup for every user that will run an Outlook workload and verify that 
email can be sent, but you must first clone the target desktop VMs.  Section 5.2 provides information 
about these final configuration tasks. 
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2.6   Gmail Account 
RAWC 3.0 allows you to use a Gmail account when running Outlook.  This means that you don’t need to 
setup the Sendmail server or an Exchange server.  Simply create a Gmail account that you want the Test 
Users to use.  Run the Gmail Setup workload to configure Outlook to use the Gmail account.  All Test 
Users will use the same Gmail account. 

 

2.7  Creating Active Directory Users    
Create one user in Active Directory for each target desktop VM you want to use in the test. Appendix A: 
vdiusers-v1 Script provides a script that you can use to create these users. Alternatively, you can create 
users manually, or your customer may have procedures or scripts that you can use to create users. 
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2.8  Creating and Configuring Desktop VMs   
You will use the first target desktop VM you create as a master image from which other target desktop 
VMs can be cloned after it is fully configured. In this guide, the target desktop VM master is named 
WIN10-VM-00.  Before proceeding make sure that the Windows 10 Operating System has been licensed 
and updated with the latest patches and VMware Tools has been installed.  Join to the domain and login 
as the Domain Administrator to install the software. 

 

2.8.1   Installing the Desktop RAWC Workload on Win10-VM-00   

This section shows how to install the Desktop RAWC workload application. 

The file required for the following procedures are in the DesktopRawcSetup_3.0.zip file that you 
previously downloaded and unzipped on the RAWC Controller VM.  You can map a Network Drive to the 
Log_Folder on the RAWC Controller VM, copy the  DesktopRawcWorkloadSetup.msi file 
over and then disconnect the Network Drive. 

To install the Desktop RAWC workload application 

1. Run the workload application setup program, DesktopRawcWorkloadSetup.msi. 

a. If the DesktopRawcWorkloadSetup.msi. is on the RAWC Controller VM, simply map 
a network drive and copy the file over to this VM.   

b. Be sure to disconnect from the network drive before proceeding as you will be mapping the 
network drive during the installation. 

2. Click the Next button. 

3. Click Browse to select the installation folder or accept the default. 

4. Select Everyone and click Next. 

5. Click Next to start the installation. The Shared folder location dialog box is displayed. 

Figure 3 - Shared Folder Location Dialog Box 

 
6. In the Shared folder location dialog box: 

a. Shared Location Path * – Click Browse to select the Log_Folder created during RAWC 
Controller setup. 

b. Drive Letter * – Select from the drop-down menu the drive to which the Log_Folder will be 
mapped. 

c. User and Password – If the folder is shared to Everyone you can leave these fields empty. Some 
customer environments might require that you enter a user and password if access is needed to 
shared folders not present on the Desktop RAWC Controller. 
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The installer tests share access by mapping and un-mapping the shared location using the provided 
information. This information is stored in a text file and is used to map the drive to shared folder when 
the workload is run and the user logs in. 

7. When the installation is complete, click Close to exit. 

 

2.8.2    Horizon Agent 

A Horizon Agent must be installed on each target desktop VM. Use a 32- or 64-bit agent depending upon 
whether the target desktop VM has a 32- or 64-bit OS installed. 

 

2.8.3 Installing and Configuring Applications on Win10-VM-00   

Install the applications that will be used for the test on the target desktop VM, Win10-VM-00. If an 
application path or file name does not match what is expected, RAWC will not work. A test script is 
provided (see Section 2.8.6) to verify that everything is in the right location. 

Some application files are provided with Desktop RAWC, but you must provide your own licensed copies 
of applications such as Microsoft Office or a (.wmv) file for Windows Media Player. Be sure to resolve 
any licensing issues with the software packages. If you do not install a software package or do not want 
to include an application in the test, verify that the corresponding application option is not selected in 
the Desktop RAWC UI. 

 

You need only to install and configure the applications that you will be running in the tests. 

 

2.8.3.1 Microsoft Office 

Install and license Microsoft Office Professional 2016 with the latest patches and verify that one of the 
following paths exists: 

 C:\Program Files\Microsoft Office\OFFICE16\<application name> 

 C:\Program Files (x86)\Microsoft Office\Office16\<application name> 

Where application name is WINWORD.EXE, EXCEL.EXE, POWERPNT.EXE or OUTLOOK.EXE. 

Configure Microsoft Office applications: 

 Open individual applications (Word, Excel and PowerPoint) and take care of any initial popup 
windows. 

 First things first popup window 
o Select Install updates only and click Accept. 

 Open the following PowerPoint file:  C:\Temp\Horizon6WhatsNewMod.pptx 
 If you are going to run the Outlook workload with Sendmail accounts, be sure that the Email Server 

and User Accounts have been created.  See Section 2.5 Downloading and Installing the Email 
Server Package. 

 If you are going to run the Outlook workload with a Gmail account, be sure the Gmail account has 
been setup.  See Section 2.6 Gmail Account. 

 

2.8.3.2 Adobe Acrobat Reader DC 

1. To download Adobe Acrobat Reader DC, go to: https://get.adobe.com/reader/ 
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 Deselect any options to install additional software 

 Click the Install Now button to install Adobe Acrobat Reader DC 

2. Verify that one of the following paths exists: 

 C:\Program Files\Adobe\Acrobat Reader DC\Reader\AcroRd32.exe 

 C:\Program Files(x86)\Adobe\Acrobat Reader DC\Reader\AcroRd32.exe 

Configure Adobe Acrobat Reader DC 

 Configure Group Policy Settings to set the default PDF Viewer to Adobe Acrobat Reader DC.  A xml 
file is provided with the appropriate file associations. 

o Open the Local Group Policy Editor (gpedit.msc) 
o Click Start > Run. 

o Enter gpedit.msc and click OK. 

o Select Local Computer Policy > Computer Configuration > Administrative Templates > 
Windows Components > File Explorer and double-click on Set a default associations 
configuration file. 

o Select Enabled. 

o Enter the following path in the Default Associations Configuration File input box:  
C:\Temp\AppAssoc.xml 

o Click OK and close the Local Group Policy Editor. 

 Disable Adobe Acrobat DC Updates 

o Disable the Adobe Acrobat DC Update Task: 

 At the search box, type:  task scheduler 

 Open Task Scheduler 

 Select the Task Scheduler Library in the left pane 

 Right click on Adobe Acrobat Update Task and select Disable from the drop-down 
menu. 

 Close the Task Scheduler. 

o Disable the Adobe Acrobat DC Update Service: 

 At the search box, type:  services 

 Open Services   
 Double click to open Adobe Acrobat Update Service properties 

 Under the Service status section, click the Stop button to stop the service. 

 Set the Startup type to Disabled 

 Click OK and close the Services application. 

o Disable the Adobe Acrobat DC Update via the Registry Editor: 

 At the search box, type:  regedit 

 Open the Registry Editor 

 Navigate to:  HKLM\SOFTWARE\WOW6432Node\Policies\Adobe\Acrobat 
Reader\DC\FeatureLockDown 
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 Create a new entry if it doesn’t exist:  REG_DWORD Value Name:  bUpdater  
Value:  0 

 HKLM\SOFTWARE\WOW6432Node\Adobe\Adobe ARM\Legacy\Reader\{Product 
code} 

 Double click on Mode and change the value to “0” 

 Click OK 

 Close the Registry Editor.  

o Restart Win10-VM-00 for the above changes to take effect.  

o Login and open the following PDF files: 

 C:\Temp\view-71-administration.pdf 

 C:\Temp\view-71-installation.pdf  

 

2.8.3.3 Google Chrome 

Install Google Chrome: 

1. To download Google Chrome, go to: https://www.google.com/chrome/ 

 In the Google Chrome Terms of Service window, click the Accept and Install button. 

2. Verify that one of the following paths exists: 

 C:\Program Files\Google\Chrome\Application\chrome.exe  

 C:\Program Files(x86)\Google\Chrome\Application\chrome.exe 

Configure Google Chrome: 

 Open Google Chrome. 
 Set the home page to your favorite URL. 

 

2.8.3.4 Mozilla Firefox 

Install Mozilla Firefox: 

1. To download Mozilla Firefox, go to: https://www.mozilla.org/en-US/firefox/new/ 

 If the Default Browser popup window appears, uncheck the check list box and close the 
window from the upper righthand corner. 

2. Verify that one of the following paths exists: 

 C:\Program Files\Mozilla Firefox\firefox.exe  

 C:\Program Files(x86)\Mozilla Firefox\firefox.exe 

Configure Mozilla Firefox: 

 Open Firefox. 
o In the Default Browser popup window 

 Deselect Always perform this check when starting Firefox 
 Click the Not Now button. 

 No configuring required.  RAWC will open Firefox to www.google.com website during the test. 
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2.8.4   Configuring the Applications on Win10-VM-00   

There are some applications that require additional configuring.  While most of the applications you 
install on the target desktop VM Win10-VM-00 use provided files, there are a couple of Applications 
where you will need to provide the files. 

You need only to configure the applications that you will be running in the tests. 

 

2.8.4.1 Internet Explorer 

Verify that Microsoft Internet Explorer 11 is installed with the latest patches, and verify that one of the 
following paths exists: 

 C:\Program Files\Internet Explorer\iexplore.exe 

 C:\Program Files(x86)\Internet Explorer\iexplore.exe 

Configure Internet Explorer: 

 Located in:  All Applications -> Windows Accessories -> Internet Explorer 
 Open Internet Explorer: 

o Select Use Recommended security and compatibility settings 
o Click OK. 

 Set the home page to your favorite URL: 
o From the menu select Tools > Internet Options. 
o Enter the new home page URL and click OK. 

 Configure Group Policy Settings locally to prevent the running of the First Run wizard.  
o Open the Local Group Policy Editor (gpedit.msc) 
o Click Start > Run. 

o Enter gpedit.msc and click OK. 

o Select Local Computer Policy > User Configuration > Administrative Templates > Windows 
Components > Internet Explorer and double-click Prevent running First Run wizard. 

o Select Enabled. 

o From the drop-down menu under Select your choice, select Go directly to home page. 

o Click OK and close the Local Group Policy Editor. 

 

2.8.4.2 7-Zip   
 7-Zip will create a zip file based on the documents in the C:\Temp\WMDownloads directory. 
 Add any additional large files to this directory to create additional load on the server. 

 

   
2.8.4.3 File Copy 
 To run the File Copy function, you will need to do the following: 

o Locate several large files 
o On the RAWC Controller VM 

 Create a folder called RAWC_Copy_Files in the Log_Folder directory. 
 Example:  C:\Log_Folder\RAWC_Copy_Files 

 Place the large files in this directory 
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o Use RAWC_Copy_Files as the File Copy Source Directory when you configure a test.    

 

2.8.4.4 Photos 

Verify that the files can be viewed: 

 Go to:  C:\Temp\Pics4RAWC\   
 Open each of the PNG files in the folder and Unblock if necessary. 
 Photos are from Pexels and are covered by Pexels license and are free to use.  

https://www.pexels.com/creative-commons-images/   

 

2.8.4.5 Sleep 
 No configuring required.  Use the Sleep function to give the user a coffee break or use in a logon 

/ logoff test scenario. 

 

2.8.4.6 Windows Media Player 
Verify that Windows Media Player 12 is installed and verify that one of the following paths exists: 

 C:\Program Files\Windows Media Player\wmplayer.exe 

 C:\Program Files(x86)\Windows Media Player\wmplayer.exe 

Configure Windows Media Player: 

 To use the Windows Media Player, locate a Windows Media Video (.wmv) file and place in:  
C:\Temp\WMdownloads. 

 Write down the name of the file as it will be needed when you configure a test. 
 Check the Properties of the file and ‘Unblock’ if necessary. 
 Open Windows Media Player and select Recommended settings and click Finish.     
 Configure Group Policy Settings locally to suppress user customization pop-ups. 

o Open the Local Group Policy Editor (gpedit.msc) 
o Click Start > Run. 

o Enter gpedit.msc and click OK. 

o Select Local Computer Policy > Computer Configuration > Administrative Templates > 
Windows Components > Windows Media Player and double-click Do Not Show First Use 
Dialog Boxes. 

o Select Enabled. 

o Click OK to close window and close the group policy editor window. 

 Open your video file and verify that is runs. 

 

2.8.4.7 YouTube Video 

To run a YouTube Video, you will need to do the following: 

o Configure Internet Explorer, see section 2.8.4.1 above. 
o Locate the YouTube URL you want to run.  You will need the URL when you configure a test. 
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2.8.4.8 Notepad 
 Open Notepad located in:  All Applications -> Windows Accessories -> Notepad 
 Verify the default printer:  File -> Print....  Windows 10 should default to Microsoft Print to PDF 

without any intervention. 
o If not, set the default printer via the Registry Editor: 

 At the search box, type:  regedit 

 Open the Registry Editor 

 Navigate to:  HKLM\HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Windows\ 

 Double click on Device and change the value to “Microsoft Print to 
PDF,winspool,Ne02:” 

 Click OK 

 Close the Registry Editor.  

Figure 4 - Default Printer for Notepad 

 
 

 

2.8.5 Control Panel Settings 

Change the following Control Panel Settings to facilitate the testing. 

2.8.5.1 Suppressing the UAC Prompt  

When a user logs into a Windows 10 target desktop VM, a User Account Control (UAC) setting sends a 
prompt asking if the Windows registry can be modified. This should be suppressed so that it does not 
occur during your test. 

To suppress the UAC prompt 
1. Select Control Panel > System and Security > Security and Maintenance > Change User Account 

Control Settings 
2. Drag the slide bar to Never notify 
3. Click OK 
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2.8.5.2 Set Display and Sleep options 

You will want to set the Power Options for the display.  You do not want the VMs to fall asleep during 
the test. 

To set the Power and Sleep options 
1. Select Control Panel > Hardware and Sound > Power Options > Choose when to turn off the 

display 
a. Turn off the display > Change to Never 
b. Click Save changes 

2. Select Control Panel > Hardware and Sound > Power Options > Change when the computer 
sleeps 

a. Turn off the display > Change to Never 

 

2.8.5.3 Turn off Windows Firewall 

When a user logs into a Windows 7 target desktop VM, a User Account Control (UAC) setting sends a 
prompt asking if the Windows registry can be modified. This should be suppressed so that it does not 
occur during your test. 

To turn off the Windows Firewall suppress the UAC prompt 
1. Select Control Panel > System and Security > Windows Defender Firewall > Turn Windows 

Defender Firewall on or off  
a. Turn off All Windows Firewalls 
b. Click OK 

2. Close the Control Panel application 

 

2.8.6   Executables and File Locations on RAWC VM WIN10-VM-00 

To verify that executables and files are in the right locations and suppress pop-ups 

1. Login to WIN10-VM-00 as Administrator and stop the RAWC workload application by right-clicking 
on the AutoIT icon on the bottom-right in the status bar of the VM. The workload application starts 
automatically after the user logs in. 

2. Add the test users’ Active Directory group to the local Administrators group. This ensures that test 
users have full permission to run the workload. 

3. Add the test users’ Active Directory group to Remote Desktop Users to allow Horizon sessions to 
these desktops. 

4. To verify your setup before cloning other VMs from VM WIN10-VM-00, select Start > All Programs > 
VMware > VMware Desktop RAWC Workload Test Locations or use the short-cut located on the 
desktop . This script verifies that all executables and files are in the proper locations 

Resolve any issues for the applications you are using for the test and re-run the script until all files 
are in the proper place. 

5. Open applications using the test user account(s) to satisfy any user-specific prompts and verify that 
each application can run without any issues: 

 Open Microsoft Word, Excel and PowerPoint, and respond to all user customization prompts. 
Close and open them again to verify that no prompts are displayed when the user runs these 
applications. 
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 Open Internet Explorer and respond to all user customization prompts. Close and open them 
again to verify that no prompts are displayed when the user runs it. 

 Open Notepad and verify that the default printer is Microsoft Print to PDF 

 Open Adobe Acrobat Reader and respond to any user customization prompts. Close and re-open 
the application to verify that no prompts are displayed when the user runs this application. 

a. Go to C:\Temp and open the two PDF documents and verify that no prompts are 
displayed. 

 Open Windows Media Player and respond to any user customization prompts.  Run the video 
you have placed in the C:\Temp\WMdownloads folder to verify that the Windows Media Player 
can open and run the video without any issues. 

 

The WIN10-VM-00 master is now complete.  Conduct a pre-test to validate the setup before cloning to 
create additional target desktop VMs. Section 4 provides information about conducting a pre-test. 
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2.9  Creating Session Launcher VMs  
Set up one or more session launcher VMs to launch desktop sessions. Each session launcher VM can 
support 20 to 50 target desktop VMs. The session launcher VMs should be on a different ESX host than 
the target desktop VMs so that the session launcher VMs do not impact performance data. 

Install a Horizon Client on each session launcher VM. A Horizon Connection Server is also required. 

To install the Desktop Session Launcher 

1. On every session launcher VM, run DesktopSessionLauncherSetup.msi. (This file is 
included in the DesktopRawcSetup_3.0.zip file that you previously downloaded.) 

2. Click Browse to select the installation folder, or accept the default. 

3. Select Everyone or Just me to specify who should have access to Desktop RAWC, and click Next. 

4. Click Next to start the installation. 

5. In the Shared Folder Location dialog box: 

a. Shared Location Path * – Click Browse to select the SessionLauncher_Share created 
during RAWC Controller setup. 

b. Drive Letter * – Select from the drop-down menu the drive to which 
SessionLauncher_Share will be mapped. 

c. User and Password – If the folder is shared to Everyone you can leave these fields empty. 

The installer tests share access by mapping and un-mapping the shared location using the provided 
information. This information is stored in a text file and is used to map the drive to shared folder 
when the workload is run and the user logs in. 

6. When the installation is completed, click Close to exit. 

The installer places the Desktop Session Launcher executable in the Startup folder so that desktop 
sessions are automatically launched when you log into a session launcher VM. 

7. Set the Display Resolution:  1024 x 768. 

a. This is an important step, as some applications in the Desktop RAWC Workload require 
specific screen coordinates and require a 1024 x 768 screen resolution. 

8. Control Panel settings 

Change the following Control Panel Settings to facilitate the testing. 

To set the Remote Connections setting 

a. Select Control Panel > System and Security > System > Remote Settings 

b. Select the Remote tab. 

c. Under the Remote Desktop section, select Allow remote connections to this computer 
(Allow connections only from computers running Desktop with Network Level 
Authentication (recommended))     

d. In the System Properties window, click Apply. 

e. In the System Properties window, click OK. 

To set the Power and Sleep options 
a. Select Control Panel > Hardware and Sound > Power Options > Choose when to turn 

off the display 
a. Turn off the display > Change to Never 
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b. Click Save changes 
b. Select Control Panel > Hardware and Sound > Power Options > Change when the 

computer sleeps 
i. Turn off the display > Change to Never 

ii. Click Save changes 
iii. Close the Control Panel application. 

Caution   You can disconnect from a session launcher VM after logging in, but do not log off. If you log 
off the sessions will close and end the test. 

 

Install and Configure the VMware Horizon Client 

1. Install a VMware Horizon Client. 

2. To configure the VMware Horizon Client, open the Horizon Client from shortcut on the desktop. 

a. Open the Options pull down menu 

b. Select the Log in as current user setting from the Options pull down menu 

i. A check mark should be visible next to Log in as current user 

c. Select the Configure data sharing…  option from the Options pull down menu 

i. Select Off to turn off the Data sharing mode. 

ii. Click OK. 

This completes the necessary configuring of the Horizon Client for RAWC. 
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3 Configuring and Launching a Test 
Use the Desktop RAWC UI to configure and launch the pre-test and the full test. This section shows you 
how to use the RAWC UI, but you do not actually use it until you are ready to configure a pre-test or full 
test. 

3.1  Configuration Tab 
Use the Desktop RAWC UI Configuration tab to configure the test. Default values are populated when 
the UI is displayed. Do not change the default values if you are not using them. 

To configure a test 

1. On the RAWC Controller, double-click the icon or file name to open the Desktop RAWC UI. 

Figure 5 - Configuration tab 

 
2. Complete the General section (asterisks indicate required fields): 

 Test Name * – Enter the test name (maximum = 50 alphanumeric characters). The test name is 
written to the configuration file and the error and timing logs. 

 Description – Enter a description of the test (200-character limit). For example, “Pre-test of a 
single VM.”  The test description is written to the configuration file and the error and timing 
logs. 

 Log Folder * – Click Browse to find and enter the name of the log folder to be used for the test.   

 Email Server – Click Edit Settings to configure the Email Server if you are using Outlook with the  
Sendmail Server or Gmail account information for the test. If you are not running Microsoft 
Outlook with a Sendmail account or Microsoft Outlook with a Gmail account, do not change any 
of these values.  See Figure 6. 
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Figure 6 - Email Server Settings 

 
 

 Select the corresponding radio button for either Outlook with a Sendmail account or 
Outlook with a Gmail account. 

 For Outlook with a Sendmail account complete the following: 

a. Email domain name – Enter the domain name of the Email Server. 

b. Incoming mail server – Enter the IP address or fully qualified domain name of the 
Email Server. 

c. Outgoing mail server – Enter the IP address or fully qualified domain name of the 
SMTP server. 

d. Password – Enter the password to the email server that you used when the guest 
users were configured (default = abc123). 

 For Outlook with Gmail account complete the following: 

a. Username – Enter the Username of the Gmail account. 

b. Password – Enter the password of the Gmail account. 

Click OK.  This completes the Email settings 

 

 Application Launch Order – Select Random or Static. This determines whether application 
workloads are launched randomly or in a static order. 

 Random – This is the standard mode in RAWC. By running applications in a random order, 
applications are executed in a different (random) order on different virtual machines. When 
running applications in a random order: 

 A varying start delay is in effect, depending on number selected for Total # of VMs 
under test. 

 The random delay between applications (Application Launch Delay or Thinktime) is 
calculated on the fly. When running applications in random mode, you choose the 
upper limit number used in the random delay calculation. 

 Static – By running applications in a static order, all virtual machines run the exact same 
test, including applications running in the same order and with fixed a fixed Thinktime 
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between the applications. This feature gives you the ability to repeat a test over and over. 
When running applications in a static order: 

 The applications selected run in the exact same order for each iteration on each virtual 
machine. 

 There is no start delay in effect. A varying start delay in this situation is irrelevant as 
the exact same applications are running on each virtual machine.  All virtual machines 
will start the test after completing the fixed delay. 

 The random delay between applications (Application Launch Delay or Thinktime) is 
now a fixed delay. When running applications in static order, the upper limit number 
that is selected becomes the actual delay between the applications. 

 Application Launch Delay or Thinktime – Select the launch delay in seconds. The application 
launch delay is used to either increase or decrease the load on the server by running the 
applications closer or further apart. 

 When running applications in a random order, the number selected for the application 
launch delay becomes the upper limit of a random delay that is calculated on the fly. For 
example, the random delay that is calculated could be 1 second or 120 seconds or any 
number in-between if 120 seconds is selected. 

 When running applications in a static order, the number selected for the launch delay 
becomes the actual fixed delay between applications. 

 Typically, the greater the number of virtual machines under test, the larger a number you 
should select (above 120 seconds). 

 By selecting a lower number, you can generate a heavier load by making the applications 
run closer together. 

 Total # of VMs under test * – Select the number that is closest to the total number of target 
desktop VMs involved in the test. Default is 10. This feature enables you to simulate a normal 
login scenario or create a more intensive boot storm. 

A normal login scenario allows virtual machines to start their workloads over a period of time. 
Select the number of virtual machines that is closest to the number of virtual machines you have 
under test. This determines the staggered start delay of the VMs as follows: 

 10 VMs:  No delay 

 64 VMs:  0 – 12 minute delays 

 250 VMs:  0 – 24 minute delays 

 500-1000:  VMs 0 – 54 minute delays 

A boot storm occurs when more virtual machines start their workloads closer together, thus 
creating a higher load on the server. A boot storm scenario may occur after systems have 
recovered from a power outage or when users log in first thing in the morning. A boot Storm 
scenario can be created by selecting a lesser number of virtual machines under test. For 
example: if you are running a 500 VM test, select 250.  That causes 500 virtual machines to start 
within 0 to 24 minutes of each other. 

 Test Mode – Select Iterations and enter the number of iterations you want the target desktop 
VMs to run (default = 3, maximum = 1000), or select Duration and enter the number of minutes 
(default = 120) you want the test to run. 
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 Iterations – Select the number of iterations you want the virtual machines to run. If you are 
interested in the open and close times of applications, run at least four iterations. 
Applications take longer to open the first time—by the second iteration, applications/pages 
have been cached and the open times are shorter. 

 Duration – Select the number of minutes you want the test to run. When using duration: 

 Virtual machines do not finish at exactly the same time or exactly at the end of the 
specified duration. 

 Time checks are performed before and after random (or static) delays between 
applications. 

 Time checks are also performed at certain points while an application is performing 
tasks. For example: a time check occurs before and after an email is sent, but not 
during the creation of the email. A time check also occurs before and after the slide 
presentation. 

 When the duration time has elapsed, the log files are closed and the desktop is 
cleaned up of any open applications. 

 Logoff User(s) after Test Completion – Select to automatically log off desktop users after the 
test completes. Otherwise, you will have to logoff every user using the Horizon Client or 
Terminal Services Manager, or you can restart the VMs from vSphere Client. 

 Test Scenario – Select to run either one test or many tests without having to logon or logoff for 
each test.  When running in the ‘Many’ mode, RAWC stays in a loop looking for the 
configuration file in the Network Share folder.  This allows you to change the test configuration 
between tests.  When RAWC completes the first test, it then looks for the configuration file for 
the next test.  Additionally, you can schedule a test to start in the future.  Suggest using the 
default values until you are familiar with running RAWC. 

 Number of Tests – Select One or Many.  This determines whether RAWC will run only one 
test or will stay in a loop and run additional tests (without logging off and then logging back 
in).   

 Start Tests – Select Now or Future.  This determines whether RAWC will start as soon as it 
sees the configuration file or wait till a future time to start the test. 

 Start Time – Select the Time to start the test.  Time is in the 24 hour format hr:mm.  If Now 
is selected, the Start Time is ignored.   

Note:  The test user must remain logged in to run in the ‘Many’ Test Scenario mode.  To end a 
‘Many’ Test Scenario, select One, then follow steps 15-17 below. 

Note:  For additional information on the Test Scenario feature, see Appendix C.  

3. In the Workload section, configure one or more applications/workloads. 

 Select the checklist box under each application you want to run in the test.  

 Some applications have additional variables that can be configured.   

 Some applications have text boxes in which you can enter text such as a URL. 

4. In the Outlook portion of the Workload section, in the # of emails field select the number of emails 
to create and send.  If you are running Outlook or Gmail enter the number of emails you want to 
generate. Outlook opens, sends one email, and then minimizes. Outlook is maximized at a later 
point during the test and generates the number of emails specified.  Gmail will   

Note:  You will also want to select Outlook Setup to set up the Sendmail account in Outlook. 
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Note:  You can only run Outlook Setup and Outlook or Gmail Setup and Gmail in the same test. 

5. In the Gmail portion of the Workload section, in the # of emails field select the number of emails to 
create and send.  If you are running Outlook with a Gmail account enter the number of emails you 
want to generate.  Outlook opens the Gmail account and sends the number of emails specified then 
closes. 

Note:  You will also want to select Gmail Setup to set up the Gmail account in Outlook. 

Note:  You can only run Outlook Setup and Outlook or Gmail Setup and Gmail in the same test. 

6. In the Word Doc portion of the Workload section, enter the typing speed and number of random 
words to generate: 

 Typing speed – Select one of the values. 

 # of random words – If you selected Random Word Doc, select the number of random words to 
be generated. The default is 400. 

7. In the Firefox portion of the Workload section, enter a URL for Firefox to go to and browse the 
page. 

8. In the PDF Browse portion of the Workload section, in the Pages to browse field, select the number 
of PDF pages for Adobe Acrobat Reader DC to browse. If you are not running Adobe Acrobat Reader 
DC, leave it at 15 (default). 

9. In the PDF Scroll portion of the Workload section, select the scroll speed and time to scroll: 

 Scroll speed – Select one of the values.  A scroll speed of 1 is very slow and a scroll speed of 9 is 
very fast.  

 Scroll time – Select the amount of time you want to scroll in the PDF document. 

10. In the Media Player portion of the Workload section, enter the file name of the video (ending in 
.wmv). 

 Verify that the video file is in this directory:  C:\Temp\WMdownloads  

11. In the File Copy portion of the Workload section, enter the name of the directory containing files to 
be copied over to the target VM. 

 If you created a directory on the RAWC Controller:  C:\Log_Folder\RAWC_Copy_Files 

 Input RAWC_Copy_Files in the File Copy Source Directory text box. 

12. In the Sleep portion of the Workload section, select the number of seconds you want the RAWC 
Workload to sleep. 

13. In the YouTube portion of the Workload section, enter the URL of the YouTube video you want to 
run. 

14. When you are done configuring the application for the test, click the 1. Save Workload button and 
respond to prompts.  

15. When you are done making changes in the General section, click the 2. Save Configuration button 
and respond to prompts. 

16. After all changes have been made, click the 3. Set as active workload button and respond to 
prompts.  This will copy the configuration file to the shared network folder on the RAWC Controller. 

Note Clicking the 3. Set as active workload button will automatically back up any existing 
configuration files in the shared Log_Folder to a subfolder with a folder name in the format: <backup 
date/time>. 
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3.2   Session Launcher Tab 
Use the Session Launcher tab to create session launcher configuration files and to launch the sessions. 
Figure 7 shows the Session Launcher tab. 

Figure 7 - Session Launcher Tab 

 
3.2.1 Creating Session Launcher Configuration Files 

To create session launcher configuration files 

1. Click the Session Launcher tab. 

2. Click Browse to select the SessionLauncher_Share folder to create session launcher 
configuration files. 

3. Click Create session launcher configuration files link to create one or more session launcher 
configuration files.  The following Session Launcher window is displayed, see Figure 8. 
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Figure 8 - Create Session Launcher Configuration Files 

 

 Enter a session launcher host name or IP address, and click Add. The session launcher host name or 
IP address you enter is pinged to verify that it can be reached from the Desktop RAWC Controller.  

 If the host name or IP address cannot be pinged, a popup window will be displayed 
indicating that the RAWC Controller was unable to ping the host name or IP address. 

 In the Section, Target Desktop VM Horizon User Session: 

 Horizon Pool Name – Enter a “Horizon Desktop Pool” name. 

 Domain – Enter *DefaultDomain* or the FQDN for the domain. 

 User Name Prefix – Enter a prefix for the user name. A numeric suffix is added to the prefix to 
create a full user name. For example, DesktopUser1, DesktopUser2, and so on. 

 Suffix Begin # – Enter a value for the first user in the range of users for this user name prefix. 

 Suffix End # – Enter a value for the last user in the range of users for this user name prefix. 

 Password – Enter the password for the session launcher. 

 Horizon Connection Server – Enter the host name or IP address of the Horizon connection 
server. 

 Horizon Connection Protocol – Select Blast, PCoIP or View RDP. This is the protocol that 
Horizon Client sessions will use to connect to target desktop VMs. 
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 Session Launch Delay – Use the drop-down menu to select a value in seconds for the launch 
delay (default = 15 seconds). This is the delay between target VM session launches from a 
session launcher. 

 Click Create Configuration Files. 

Repeat this procedure for each session launcher configuration file you want to create. 

Notes: 

 If you want to use fullscreen desktop for the View Client window, in the 
SessionLauncher_Share folder, edit view-commandline.txt and add the option -
desktopLayout fullscreen. 

 You can optionally add other View Client command-line options as specified in the VMware 
View Administration Guide. 

 

3.2.2 Opening Session Launcher VMs 

Session launcher VMs are zombie VMs that are used to launch user sessions to the target desktop VMs 
where the workload is executed. On the Desktop RAWC UI Session Launcher tab, click Open Session 
Launcher VMs to open the session launcher VMs, which in turn launches user sessions on target desktop 
VMs.  See Figure 9 – Opening Session Launcher VMs 

Figure 9 - Opening Session Launcher VMs 

 
When an RDP session is opened to a session launcher VM, the session launcher software is automatically 
executed because there is a shortcut to the desktop session launcher executable in the Startup folder. 
The session launcher then maps the drive to SessionLauncher_Share, reads the input file 
associated with each session launcher VM from the network share, and sequentially launches one user 
session to each target desktop VM.  Note:  Up to 50 sessions per Session Launcher VM has been tested. 
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3.2.3 Launching Desktop Sessions 

To launch VMware Horizon desktop sessions from the Desktop RAWC UI 

1. On the Session Launcher tab, click Browse to select the folder SessionLauncher_Share. This 
reads all input configuration files created for each session launcher and displays the datagrids. 

2. To launch the target desktop sessions, click Open Session Launcher VMs. 

Note:  An RDP session to the session launcher VM opens in a window. To use full screen mode, change 
screen mode id:i:1 to screen mode id:i:0 in the file template.rdp under Desktop RAWC UI install 
location.  As an example:  C:\Program Files (x86)\VMware\VMware Desktop 
RAWC\temp\<ipaddress>_domain_administrator.rdp 

3. Click OK on the message pop-up indicating how many RDP sessions to Session Launcher VMs will be 
launched or click Cancel to cancel the launch and return to UI. 

4. Enter user login information to open the sessions to the session launcher VMs. The same user 
information is used to open RDP sessions to all session launcher VMs. 

Note:  Be sure to restart the GuestOS on the Session Launcher VMs between test runs. 

 

To launch VMware Horizon desktop sessions from a Session Launcher VM 

This is an alternative for launching the user sessions and leaves the RAWC Controller open for viewing 
error and timing log files as well as modifying the configuration manually. 

1. Restart the GuestOS on the Session Launcher VM.   
2. Open a Remote Console on the Session Launcher VM. 
3. Login to the Session Launcher VM as Domain\Administrator.  The RAWC Session Launcher software 

will start automatically. 
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4 Conducting a Pre-test 
The objective of conducting a pre-test is to: 

 Verify that log folders can be created in the shared network folder (Log_Folder and 
SessionLauncher_Share) on the RAWC Controller. 

 Verify that the target desktop VM can deposit error and timing log files in the shared network 
folder. 

 Verify that the configuration file can be created and launched. 

 Verify that the selected applications can run on the target desktop VM,  

 Verify that the Email user can be set up, and Email can be created and sent (Email Server is 
functioning correctly).  Note:  required only if you are running Outlook or Gmail. 

 Verify that Microsoft Word, Excel and PowerPoint can be opened without additional user-specific 
customization prompts. 

 Verify that Internet Explorer, Google Chrome, Firefox and Windows Media Player can be opened 
without additional user-specific customization prompts. 

 Verify that Adobe Acrobat Reader DC can be opened without additional user-specific customization 
prompts. 

 Verify that photos can be viewed in the Phots application. 

 Verify that the Notepad application can print to a PDF file. 

 After the test is completed, verify that the error and timing log files have data. 

Always run a pre-test to verify the setup is valid before running a test.  You need only to verify the 
applications that you will be running in the test. 

4.1  RAWC Controller 
Verify that the Desktop RAWC UI can create the log folders on the RAWC Controller. 

To verify that the UI can create log folders 

1. Set up the pre-test and configure the workload you want to run by selecting the appropriate test 
settings and applications using the Configuration tab. Setting up a pre-test is the same as setting 
up a test, but you only use one session launcher VM and the WIN10-VM-00 target desktop VM.   

2. After selecting the applications and appropriate test settings click the following buttons and 
respond to any popup messages:   

 Click 1. Save Workload – saves the workload (applications) 

 Click 2. Save Test Configuration – save the test configuration (General section) 

 Click 3. Set as active workload – creates the configuration file 

3. Verify that the Error and Timing log folders have been created on the RAWC Controller.  See the 
Folder created with the Test Name in Log_Folder folder. 

4. For a pre-test on Win10-VM-00 start the test by simply restarting the GuestOS Win10-VM-00 
and login as a Test User or Administrator. 

5. For a pre-test with a small Pool of VMs (i.e. 5 VMs): 
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 On the Session Launcher tab, create the Session Launcher configuration files (see 
section 3.2.1 above). 

 On the Session Launcher tab, click Open Session Launcher VMs to start the test, or 

 Restart the GuestOS on the Session Launcher VM and login as Administrator. 

6. Verify that the AutoIT icon (small, gray, round icon) is present on the bottom-right of the status 
bar for the target desktop VM, as viewed from the Session Launcher VM. 

7. WIN10-VM-00 writes a text file to the started folder in the shared network folder on the 
RAWC Controller. The presence of <DomainName>_<UserName>_<IPAddress>.txt file 
indicates that the RAWC Workload has been started.  This file contains the following 
information:  VM Name, UserName, IP Address, Date and Time that the RAWC Workload 
started. 

8. After the configuration file has been launched from the Desktop RAWC UI and the test has 
started on Win10-VM-00, verify that the following text files have been created in the log folder 
on the RAWC Controller: 

 <NA>.<DomainName>.<UserName>.Timinglog.Open.<IPAddress>.txt  

 <NA>.<DomainName>.<UserName>.Timinglog.Close.<IPAddress>.txt 

 <NA>.<DomainName>.<UserName>.Errorlog.<IPAddress>.txt  

9. Depending on the number of target desktop VMs under test, there may be a start delay on the 
VM. An Information box will be displayed on the VM’s desktop with a countdown until the test 
starts. 

10. Close the console on WIN10-VM-00. 

 

Caution You can watch the test by keeping the console open on Win10-VM-00 or Session Launcher VM, 
but do not perform any work or click the mouse in the console as this will take focus away from the 
application and jeopardize the test. 

 

 

4.2  Pre-test Results 
After completing an initial test run on WIN10-VM-00, check the following files on the RAWC Controller: 

 <NA>.<DomainName>.<UserName>.Timinglog.Open.<IPAddress>.txt           
File used to capture open times on the applications.  Also note that the configuration for the 
test is also written to this file. 

 <NA>.<DomainName>.<UserName>.Timinglog.Close.<IPAddress>.txt         
File used to capture save and close times on the applications. 

 <NA>.<DomainName>.<UserName>.Errorlog.<IPAddress>.txt                            
File used to collect errors if an application should fail. 

 

Resolve any problems found and re-run the pre-test until everything is in place. 
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5 Final Configuration 
After completing a successful pre-test but before running a full test, clone target desktop VMs, prepare 
input files for session launcher VMs and complete Outlook Setup. 

5.1  Cloning Target Desktop VMs 
From the WIN10-VM-00 master, take a snapshot and clone as many target desktop VMs as you need for 
a full test. 

5.2  Completing Outlook Setup or Gmail Setup and Verifying Emails Messages 
Run Outlook Setup or Gmail Setup once per user per desktop VM and confirm that emails are being 
successfully sent and received. This must be done after the pre-test, but before running a full test. 

Caution If Microsoft Outlook (either Outlook or Gmail) is part of the workload, use a persistent desktop 
pool so that users will get the same desktop for every test. You can also run Outlook Setup and Gmail 
Setup in every test, but this can add additional time to the test and there is the potential of additional 
errors as the Outlook Setup and Gmail Setup workloads are sensitive to load.  

Note:  Microsoft Outlook is used for both Sendmail accounts and Gmail accounts. 

To run Outlook Setup for users 

1. On the Desktop RAWC UI, click the Configuration tab. 

2. Select Outlook Setup or Gmail Setup only. Verify that no other applications (workloads) are 
selected. 

 Be sure to select logoff to log off the users after the test is completed. 

3. Save the configuration by clicking the following buttons and responding to any popup messages:   

 Click 1. Save Workload – saves the workload (applications) 

 Click 2. Save Test Configuration – save the test configuration (General section) 

 Click 3. Set as active workload – creates the configuration file 

4. Click the Session Launcher tab. 

5. Click Open Session Launcher VMs. Outlook Setup or Gmail Setup is run for each user on every target 
desktop VM. The setups run in parallel. 

6. After Outlook Setup or Gmail Setup has been completed on all target desktop VMs, verify that there 
are no open sessions on the Session Launcher VM.   If there are open sessions, more than likely an 
error has occurred.  Simply close the Outlook application and restart the RAWC Workload from the 
icon on the session’s desktop.  

To verify that the Outlook or Gmail workload can send email 

1. On the Desktop RAWC UI, click the Configuration tab. 

2. Select Outlook or Gmail only. Verify that no other applications (workloads) are selected. 

3. Save the configuration by clicking the following buttons and responding to any popup messages: 

 Click 1. Save Workload – saves the workload (applications) 

 Click 2. Save Test Configuration – save the test configuration (General section) 

 Click 3. Set as active workload – creates the configuration file 

1. Click the Session Launcher tab. 



38 

 

2. Click Open Session Launcher VMs.  Outlook or Gmail is run for each user on every target desktop 
VM. 

3. Check several sessions and review the Outlook Inbox for a sampling of users to verify that email 
messages have been received. 

4. After Outlook has completed on all target desktop VMs, verify that there are no open sessions on 
the Session Launcher VM.   If there are open sessions, more than likely an error has occurred.  You 
can close any application windows and rerun RAWC from the icon on the desktop.   
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6 Conducting a Test 
After cloning target desktop VMs and performing Outlook or Gmail Setup (if you are using the Outlook or 
Gmail workload), you can run a full test. 

6.1  Cloning Desktop VMs for the Test 
If the pre-test results indicate that the pre-test run was successful, shut down WIN10-VM-00 and use it to 
clone as many VMs as you need for a full test. 

6.2  Running the Test 
To run a test 

1. On the RAWC Controller, open the Desktop RAWC UI. 

2. Use the Configuration tab to set up the test and configure workloads. 

3. Launch the desktop sessions: 

 From the Desktop RAWC UI, click Open Session Launcher VMs to log in to session launcher VMs 
which, in turn, causes each session launcher VM to launch desktop sessions, or  

 Restart the GuestOS on the Session Launcher VM and login as Administrator. 
 

4. On the RAWC Controller, when the test finishes review error and timing log files. 
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7 Comparing and Charting Test Results 
You can use the RAWC Charting scripts, a Microsoft Excel spreadsheet and Windows performance tools 
such as the System Monitor to compare data and graph results. 

Two RAWC scripts have been developed to aid in the compilation of the RAWC timing logs.  The first 
script will consolidate the timing logs and the second will create two Excel spreadsheets (one with open 
times, the other with save and close times).  Upon completion of the scripts, you have only to format 
the summary data and insert the bar chart of your choice. 

Suggestion:  If you are running multiple tests in a limited time frame, it is advisable to have a separate 
“Results” VM with Microsoft Office (Excel installed).  This will allow you to copy log folders from the 
RAWC Controller to the Results VM where you can chart the results without interfering with the next 
test.  

On a separate Results VM 
1. Map the Network Drive to the RAWC Controller Log_Folder 

a. Shared Location Path * – Click Browse to select the Log_Folder created during RAWC Controller 
setup. 
b. Drive Letter * – Select from the drop-down menu the drive to which the Log_Folder will be 
mapped. 
c. User and Password – If the folder is shared to Everyone you can leave these fields empty. Some 
customer environments might require that you enter a user and password if access is needed to the 
shared folders not present on the Desktop RAWC Controller. 

2. Locate the RAWC_Charting_Files folder on the RAWC Controller VM. 

3. Copy and Paste the RAWC_Charting_Files folder from the RAWC Controller Log_Folder to the 
Desktop of the Results VM. 

7.1  Log Files 
The log files contain the data you need for comparisons.  As suggested above, locate the Log folders on 
the RAWC Controller and copy/paste to a separate “Results” VM. 

7.1.1 Error Log  

Locate the <NA>.<DomainName>.<UserName>.Errorlog.<IPAddress>.txt file on the 
RAWC Controller and open it. This file includes the following information if the test completes 
successfully: 

Figure 10 Error Log from a completed test with no errors. 

 
If the RAWC workload exited on the VM prior to completing all the iterations, line 5 is left blank. 

If an error occurs on the VM, the error is written to the Errorlog file. The Errorlog is then filled with 
additional characters to create a 3KB file and moved to the A_Error_Folder folder in the same 
directory for easier viewing, and the RAWC Workload script is exited. 
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Figure 11 Error log showing error. 

 
A return code of 0 (zero) indicates that the command failed. In this case, the WinWaitActive() 
command failed to find the window it was looking for, or it found the window but could not activate it. 
This typically occurs when the system is overloaded. Additional information is provided as to the 
function where the failure occurred and the iteration in which the error occurred in. If the system is 
overloaded, errors will occur in the first couple of iterations for some of the VMs, while others do not 
fail.  

  



42 

 

7.1.2 Timing Logs 

Locate the <NA>.<DomainName>.<UserName>.Timinglog.Open.<IPAddress>.txt file 
on the RAWC Controller and open it. This file includes test configuration and application open time  
information from the VM.  

Figure 12 Timing Log with Test configuration and application open times 

 
 

Locate the <NA>.<DomainName>.<UserName>.Timinglog.Close.<IPAddress>.txt file 
on the RAWC Controller and open it. This file includes application save and close time  information from 
the VM.  
Figure 13 Timing Log with close times 
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7.2  Chart Timing Log Files 
To compare like applications and operations, and chart the timing logs 

Two RAWC scripts have been developed to aid in the compilation of the RAWC timing logs.  The first 
script will consolidate the timing logs and the second will create two Excel spreadsheets (one with open 
times, the other with save and close times).  Upon completion of the scripts, you have only to format 
the summary data and insert the bar chart of your choice. 

Best Practice:  Create a separate “Results” VM with Microsoft Office 2016.  Map a network drive to the 
network share Log_Folder and copy/paste the RAWC_Charting_Files folder over to the 
“Results” VM.  When a test has completed, copy the Timing and Error Log folder over to the “Results” 
VM.  This off loads the charting work from the RAWC Controller VM.    
 

Caution:  While the scripts are running, DO NOT perform any keyboard or mouse activities, else the 
scripts may lose focus and will have to be restarted. 

To consolidate the Timing logs for charting 

1. Copy the Timing Log folder over from the RAWC Controller VM to the Results VM desktop. 

2. Locate the RAWC_Charting_Files folder on the Results VM (copied over from the RAWC 
Controller VM). 

3. Open the RAWC_Charting_Files folder. 

4. Copy and paste the A_RAWC_TLog_Consolidation script to the Timing Log folder that 
contains the timing logs that you want to chart the results for. 

5. Double click on the A_RAWC_TLog_Consolidation script to run.   

a. A_Results_Folder will be created in the timing log folder that will contain the files that will 
be used by the RAWC_Charting script. 

b. Message boxes will appear on the screen to inform you of the file that is being read and the 
number of lines being written to the separate log files, and when the script has completed. 

Notes:   

 This script will only consolidate timing logs in the folder that it is located in.  If there are 
timing logs in multiple folders, either consolidate the timing logs into one folder, or run the 
script in each folder.  Suggest consolidating all Timing Logs into one folder. 

 You may open the A_Results_Folder and watch the files grow.  Do not open any of 
these files while the Consolidation script is running.  

 You may rerun this script as often as you’d like.  The existing A_Results_Folder folder 
and files will be deleted prior to consolidating the timing logs again. 

To chart the Timing log data 

1. Open the RAWC_Charting_Files folder. 

2. Copy and paste the RAWC_Charting script to the Desktop.   

Note:  The Excel spreadsheets will be saved to the same directory where the RAWC_Charting script is 
located. 
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Figure 14 RAWC Charting GUI 

 
Note:  The RAWC Charting GUI supports Windows Server 2012R2, Server 2016 and Server 2019 in 
addition to Windows 10. 

 

3. On the desktop, run the RAWC_Charting script.  A GUI will be displayed with various options. See 
Figure 14 RAWC Charting GUI.  

1. In box 1, select one of the options to chart the application open times.  

2. In box 2, select one of the options to chart the application close times. 

3. In box 3, enter the test name (this will become part of the excel spreadsheet file name. 

4. In box 4, click on the Select Log Folder and Chart button. 

1. A window will appear.  Navigate to and select the folder that contains the timing 
logs.  Click on the Select Folder button. 

2. Two popup windows will appear.  Click the OK button in each window.  The RAWC 
Charting script will open an Excel spreadsheet and begin populating it with data. 

Note:  Message boxes will appear on the screen to inform you of the progress of 
the script and when it has completed. 

3. When the spreadsheet is completed, RAWC Charting will save it to the directory 
where the charting script is located (the desktop in this example). 

4. Open the Excel spreadsheet and locate the Summary sheet. 

1. Format the data and remove any applications (rows) that were not run in 
the test.  There will be a zero in the Time column. 

2. Insert the bar chart of your choice. 

3. Save the spreadsheet. 
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7.3  Graphing Additional Performance Data 
You can use the Microsoft System Monitor to graph results.  The following procedure shows how to 
graph the data using disk usage as an example: 

To graph test results 

1.  Click Start > Control Panel > Administrative Tools > Performance to bring up the System Monitor. 
2. Click in the graph window and press Ctrl-l (l as in load) to bring up the System Monitor Properties 

window. 
3. On the Source tab, select Log Files. 
4. Click Add. 
5. In the Select Log file dialog box, select the source log file and click Open. 
6. Click Time Range to display the time range and verify that it corresponds to the time period during 

which the test was run. 
7. Click the Data tab, then click Add. 
8. Select the data you want to graph: 

a. In the Add Counters dialog box Performance object section, select Physical Disk. 
b. Select Select counters from list. 
c. Select MBytes Read/sec and click Add. 
d. Select MBytes Written/sec and click Add. 
e. Click Select instances from list: 
f. Select DEV-vmhba1:0:0 (for example) and click Add. 
g. Select DEV-vmhba32:0:0 (for example) and click Add. 
h. Click Close. 

9. On the Data tab, remove any counters that are not needed. 
10. Select the Graph tab and enter title and parameters: 

1. In the Title field, enter a title for the graph. For example, 4 VM Test Disk Usage (Run_09_11_09). 
2. In the Vertical axis field, specify a value for the vertical axis. For example, 100. 
3. In the Maximum field, specify a maximum value for the vertical scale. For example, 15 
4. In the Minimum field, specify a minimum value for the vertical scale. For example, 0. 
5. Click OK. 
6. Click File > Save As and save the graph with a descriptive name (for example 4 VM Test Disk 

Usage(Run_09_11_09).msc) as a Microsoft Management Console file (.msc). 
7. Right-click and select Save Data As, enter a descriptive file name, select Text File [Comma 

delimited][*.csv], and click Save to save the data as a comma-separated values (.csv) file. 
 

7.3.1 Graphing Other Data 

The following shows the types of counters and instances you should add to graph various performance 
objects: 

 Performance Object: Physical CPU 
o Counter: % Processor Time 
o Instances: Select All instances 

 Performance Object: Physical Disk 
o Counters: MBytes Read/sec, Mbytes Written/sec (total reads, total writes - add 

formula) 
o Instance: DEV-vmhba32:0:0 (for example) 

 Performance Object: Memory 
o Counters: PShare Shared, PShare Savings 
o Instances: n/a 

 Performance Object: Memory 
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o Counter: PShare Common 
o Instances: n/a 

 Performance Object: Memory 
o Counters: Memctl Current, Memctl Max, Memctl Target 
o Instances: n/a 

 Performance Object: Memory 
o Counters: Swap MBytes Read/sec, Swap MBytes Write/sec 
o Instances: n/a 

 Performance Object: Memory 
o Counters: Swap Used, Swap Target 
o Instances: n/a 
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Appendix A:  vdiusers-v1 Script  

add-vdiusers-v1.ps1 
This add-vdiusers script creates users in Active Directory for test purposes. The script and a sample 
addusers.csv file are provided with Desktop RAWC. 

This script requires the following software: 

 Windows PowerShell 

 QAD cmdlets 

The following is a printout of the add-vdiusers-v1.ps1 script: 

#-- This script automatically creates, configures and enables users in Active Directory for the VMware VDI Testing Tool Kit 

#-- The script depends on PowerShell and QAD cmdlets from Qwest both are free tools – download from 

#-- 

#-- PowerShell from Microsoft -http://www.microsoft.com/windowsserver2003/technologies/management/powershell/download.mspx 

#-- PowerShell Commands for AD - http://www.quest.com/powershell/activeroles-server.aspx 

#-- 

#-- Both will need to be installed on a Windows host that has access to the AD controller in your VMware Testing Environment 

#-- Environment specific variables can be changed to handle any deviations from the VDI testing standard and examples 

#-- This script uses the vdi-adusers.csv file provided for input parameters when creating each VDI test users the most common 
object attributes have already been set. These can easily be changed for environment specific situations 

#-- Set Environment specific variables 

$ADserver='192.168.1.21:389' 

$vdiOU="DC=wadingdog,DC=com“ 

$vdiusers="CN=VDI Users,CN=Users,DC=wadingdog,DC=com" 

#-- Read user information from the vdi-adusers.csv file 

$userinfo = Import-csv "C:\vdi-adusers.csv" 

$userinfo |foreach { 

#-- Create the new users in Active Directory 

New-QADUser -Service $ADserver -ParentContainer $vdiOU -Name $_.Name -UserPrincipalName $_.UserPrincipalName -
UserPassword 

$_.UserPassword -FirstName $_.givenName -LastName $_.sn -PhoneNumber $_.PhoneNumber -PostalCode $_.PostalCode - 

SamAccountName $_.samaccountname -StateOrProvince $_.StateorProvince -StreetAddress $_.StreetAddress -DisplayName 
$_.CN 

#-- Enable the users, set additional attributes and set passwords 

Enable-QADUser $_.Name -Service $ADserver | Set-QADUser -objectattributes @{mail=$_.emailaddress} -UserPassword 'vditest' 

#-- Add each user to the restricted vdi-users group 

add-QADGroupmember -identity $vdiusers -Service $ADserver -Member $_.Name 

} 
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Figure 15 shows an add-vdiusers.csv file that provides data to the script (see the included sample 
script for details). 

Figure 15 - Sample add-vdiusers.csv file 
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Appendix B:  Optimizing a VMware Horizon Test Environment 

Some of the following tips may be useful. 

Master Desktop VM 

On the target desktop VM from which you clone other VMs: 

 If you want to see system failures and send an administrative alert when they occur: select Control 
Panel > System > Advanced > Startup and Recovery > Settings and, in the System failure section, 
select Send an administrative alert and deselect Automatically restart. 

 Check that VMs have proper memory size. 

 Upgrade VM Tools on VMs, if needed. 

 Modify Windows registry settings as needed, such as disk timeout value (how long OS will wait for a 
hard disk to respond to a command before generating errors). Recommended value is 180. 

 HKEY_LOCAL_MACHINE/System/CurrentControlSet/Services/Disk/TimeOutValue 

 Update Golden Master image with software updates and patches. 

 Disable unneeded services such as automatic updates, remote registry, Secondary Logon, SSDP 
Discovery Service, Wireless Zero, and so on. 

 Turn off System Restore. 

 Set virtual memory size properly. Click Control Panel > System > Advanced. Then, under 
Performance, click Advanced, and under Virtual Memory, click Change and specify virtual memory 
values. Usually, the Initial size and Maximum size values should be the same. A good starting point 
for a VM is to set it equal to the memory size. Increasing this value makes the Linked Clones grow in 
size, so it should be set to the smallest value that provides adequate virtual memory for the guest 
OS. 

 VMware vCenter 

 Enable the DRS cluster setting before powering on VMs. If DRS has trouble meeting requirements for 
VMs it will move them around if DRS is set to fully automated. 

 Make sure VMs are balanced across the ESX settings if you are not using aggressive DRS setting. 
Migrate VMs to a different ESX host, if necessary. 

 Increase the ESX host console memory, if necessary. A user report indicates that a value of 800MB 
helps to stabilize the environment. On vCenter, select Configuration > Memory > Properties. This 
change requires an ESX host reboot. 

 

Other Optimization 

Before deploying the virtual images, the master target desktop VM image from which the desktops are 
created should be tuned and optimized.  

 VMware OS Optimization Tool:  https://labs.vmware.com/flings/vmware-os-optimization-tool 
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Appendix C:  Test Scenario Feature Information 

The Test Scenario feature allows you to run one test or many tests without having to logon or logoff 
after each test.  When running multiple (Many) tests, RAWC stays in a loop looking for the configuration 
file in the Network Share folder.  This allows you to change the test configuration between tests.  When 
RAWC completes the first test, it will then look for the configuration file for the next test.  Additionally, 
you can schedule a test to start in the future.  Suggest using the default values until you are familiar with 
running RAWC. 

 

Number of Tests: 

 Run One test.  RAWC will run the test and will either leave the test user logged in or will log off the 
test user (based on the configuration file) before exiting the script. 

 Run Many tests.  RAWC will run a test and upon completion of that test will look for the 
configuration file in the Network Share folder in order to start the next test.  Note that the test user 
must remain logged in to run multiple (many) tests.  

o When you want to run the last test of the day, select One for the Number of Tests, so that 
the RAWC will finish after completing the test. 

Start Tests: 

 Select Now to start the test after the test user logs in. 
 Select Future to log the test user in and wait till the future time is current and start the test. 

Start Time – Use the 24-hour format HH:MM (no seconds) 

 

The following table provides information on the various scenarios and how the current time from the 
VM is compared to the start time in the configuration file. 

Number 
of Tests 

Start 
Test 

Start Time 
(HH:MM) 

Current 
Time on 
the VM 

Logoff 
User(s) 

after test? 

Comments 

One Now 10:00 09:30 Yes or No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Now is selected the start time 
and  current time on the VM  are 
ignored.   

 RAWC will run and complete the test.  
 RAWC will then exit. 
 User may log off or remain logged on. 

One Future 10:00 09:30 Yes or No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Future is selected, RAWC will 
compare the current time from the 
VM to the start time in the config file 

 If current time < start time, loop (20 
sec) until current time = start time 

 RAWC will run and complete the test. 
 RAWC will then exit. 
 User may log off or remain logged on. 
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Number 
of Tests 

Start 
Test 

Start Time 
(HH:MM) 

Current 
Time on 
the VM 

Logoff 
User(s) 

after test? 

Comments 

One Future 10:00 10:00 Yes or No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Future is selected, RAWC will 
compare the current time from the 
VM to the start time in the config file 

 If current time = start time.   
 RAWC will run and complete the test.   
 RAWC will then exit. 
 User may log off or remain logged on. 

One Future 10:00 11:00 Yes or No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Future is selected, RAWC will 
compart the current time from the VM 
to the start time in the config file 

 If current time > start time 
 RAWC will not run the test.   
 RAWC will wait till the next day when 

current time = start time then 
 RAWC will run and complete the test. 
 RAWC will then exit. 
 User may log off or remain logged on. 

Many Now 10:00 09:30 No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Now is selected the current 
time and start time are ignored.   

 RAWC will run and complete the test. 
 RAWC will loop back and copy the 

config file to the VM because Many is 
selected. 

 RAWC will run and complete the test. 
 If Many and Now are selected RAWC 

will continue running the tests. 

Many Future 10:00 09:30 No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Future is selected  
 RAWC will compare the current time 

from the VM to the start time in the 
config file 

 If current time < start time, loop (20 
sec) until current time = start time 

 RAWC will run and complete the test. 
 RAWC will loop back and copy the 

config file to the VM because Many is 
selected. 

Note:  To run a second or third test, you must 
change Future to Now or change the start 
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Number 
of Tests 

Start 
Test 

Start Time 
(HH:MM) 

Current 
Time on 
the VM 

Logoff 
User(s) 

after test? 

Comments 

time to a time in the future. 

Many Future 10:00 10:00 No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Future is selected 
 RAWC will compare the current time 

from the VM to the start time in the 
config file. 

 If current time = start time.   
 RAWC will run and complete the test. 
 RAWC will loop back and copy the 

config file to the VM because Many is 
selected. 

Note:  To run a second or third test, you must 
change the ‘start future’ to ‘start now’ or 
change the start time to a time in the future. 

Many Future 10:00 12:00 No RAWC will start and copy the config file to the 
VM, then RAWC will read the config file. 

 Because Future is selected 
 RAWC will compare the current time 

from the VM to the start time in the 
config file. 

 RAWC will not run the test.   
 RAWC will wait till the next day when 

current time = start time then 
 RAWC will run and complete the test. 

Note:  To run a second or third test, you must 
change the ‘start future’ to ‘start now’ or 
change the start time to a time in the future. 

How to stop the VMs when Many tests has been selected. 

 VMs will run one more test: 

o Select the Logoff user(s) after test completion check box. 

o Change any/all applications to run in the final test. 

o Change ‘Many’ to ‘One’ in the Test Scenario section. 

o Click the 1. Save Workload button to save the Workload (applications). 

o Click the 2. Save Test configuration button to save the Test configuration (General 
section). 

o Click the 3. Set as active workload button to create the configuration file. 

RAWC will copy over the new configuration file and run the test. 
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Appendix D:  Creating and Configuring RDS Host VMs 

You can also use the Desktop RAWC Workload to test RDS Sessions on RDS Host VMs.  The installation 
and configuring of the Desktop RAWC Workload and Applications on RDS Host VMs is nearly identical to  
VDI desktops. 

Below are the instructions for installing and configuring the Desktop RAWC Workload on an RDS Host 
VM. 

Where the instructions are the same (i.e. installing Microsoft Office 2016) you will be referred to the 
prior Application installation section for information.  This section will cover the specific installation and 
application configuration steps unique to Windows Server 2012R2, Windows Server 2016 and Windows 
Server 2019 RDS Host VMs. 

 

1. Create a Microsoft Windows Server VM for the RDS Host using one of the following 64-bit 
Operating Systems:  Windows Server 2012R2, Windows Server 2016 or Windows Server 2019. 

a. Select the Windows Server 2012R2 Datacenter (Server with a GUI) or 
b. Select the Windows Server 2016 Datacenter (Desktop Experience) or 
c. Select the Windows Server 2019 Datacenter (Desktop Experience) 

i. Configure the RDS Host with your choice of vCPUs, Memory, and Disk. 
ii. As an example, 4 vCPUs, 24 GB Memory and 64 GB Disk as a starting point. 

d. Install VMware Tools 
e. Join to the Domain 
f. Login as your ‘domain\administrator’ 

i. License the Operating System software. 
 

Install Remote Desktop Services:      
2. Go to the Server Manager tool and click Add roles and features 

a. In the Before you Begin window click Next. 
b. In the Installation Type window select Remote Desktop Services installation and click 

Next. 
c. In the Deployment Type window select Standard deployment and click Next. 
d. In the Deployment Scenario window select Session-based desktop deployment and 

click Next. 
e. In the Role Services window click Next. 

i. Note that the following Services will be installed:  Remote Desktop Connection 
Broker, Remote Desktop Web Access, Remote Desktop Session Host.  

f. In the RD connection Broker window select the computer name from the Server Pool 
box and select the arrow button to move it to the Selected box and click Next 

g. In the RD Web Access windows select the computer name from the Server Pool box and 
select the arrow button to move it to the Selected box and click Next 

h. In the RD Session Host window select the computer name from the Server Pool box and 
select the arrow button to move it to the Selected box and click Next 

i. On the Confirmation window check the Restart checklist box and click Deploy 
j. After the roles and features have been deployed, VM will restart. 
k. Login as Domain Administrator and let it finish deploying. 

 
3. Open the Control Panel and do the following:     

a. System and Security 
i. Select Windows Firewall  
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ii. Select Turn Windows Firewall on or off and turn off all Firewall components 
and click OK. 

b. Do a search on ‘Remote’  
iii. Select Allow remote access to your computer located under System heading 

1. Verify that Allow remote connections to this computer is selected and 
click OK. 

c. Do a search on ‘UAC’  
iv. Select Change User Account Control settings located under Action Center 

heading 
v. Select Never notify and click OK. 

d. Do a search on ‘power’ 
vi. Select Change when to turn off display located under Power Options heading 

vii. Select Never from the Turn off the display pulldown menu and click Save 
changes. 

e. Close the Control Panel 
 
To install the RAWC Workload software: 
 

4. Copy the DesktopRawcWorkloadSetup.msi over from the RAWC Controller VM to the 
desktop. 

a. Map a network drive to the RAWC Controller:  \\ipaddress\Log_Folder 
b. Copy the following file from the Log_Folder folder to the desktop: 

i. DesktopRawcWorkloadSetup.msi 
ii. Disconnect from Network Drive (Z:\) as you’ll be remapping to the Network 

Drive Z:\ during the RAWC installation process.  
 

5. Place the RDS Host into RD-install mode. 
a. Open a Command Prompt Window and type:  change user /install at the prompt 

 
6. Run the RAWC Workload application setup program, DesktopRawcWorkloadSetup.msi   

a. Click Next 
b. Select Everyone and click Next 
c. Click Next to start the installation.  The shared folder location dialog box is displayed. 

(the dialog box may show up behind the installer window) 
d. In the Shared folder location dialog box: 

i. Shared Location Path – Click Browse to select the Log_Folder created during 
the RAWC Controller setup, or type in the ipaddress and Log_Folder. 

ii. Drive Letter – Select from the drop-down menu the drive to which the 
Log_Folder will be mapped. (Z:  \\ipaddress\Log_Folder)       

iii. User and Password – If the folder is shared to Everyone you can leave these 
fields empty. 

The installer tests share access by mapping and un-mapping the shared location using 
the provided information.  This information is stored in a text file and is used to map 
the drive to the shared folder when the workload is run and the user logs in. 

e. When the installation is complete, click Close to exit. 
 

7. Install and Configure Applications 
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The installation and configuring of applications are the same as on the Windows 10 Desktop,   
with the exception of the applications noted below.  Recall that you only need to install 
applications you will be running in the test. 

 
a. Refer to Sections 2.8.1.1 thru 2.8.4.5 for Application installation and configuration 

information.  
b. PDF Writer for Notepad workload  

Note:  If you are going to run the Notepad workload, you will need to install a PDF 
Writer on the RDS Host VM. 

Note:  This setup is only required for Windows Server 2012R2 and Server 2016.  
Windows Server 2019 does not require any special setup. 

 To download a PDF Writer from CNet, go to:  https://download.cnet.com/PDF-
Writer-for-Windows-Server-2012/3000-18507_4-75723904.html 

 Install the PDF Writer. 
 Make a Registry change to setup the PDF Writer as the Default Printer. 

 Open the Registry Editor tool (regedit.exe) 
o Navigate to:   
o HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion\Windows 
o Modify the following entry: 
Value Name:  Device 
Type:  REG_SZ 
Value:  PDF Writer,winspool,Ne00: 

 
c. YouTube Video 

If you are going to run a YouTube video, you will need to install and configure Firefox.   

d. Final steps 
o License the Windows Operating System. 
o Update the Windows Operating System. 
o Ensure that a Horizon Agent is installed. 

 
8. Place the RDS Host VM back into RD-Execute mode. 

a. Open a Command Prompt Window and type:  change user /execute at the prompt 
b. For more information, see the Microsoft TechNet article:  Learn How To Install 

Applications on a RDS Session Host Server.  https://technet.microsoft.com/en-
us/library/ff432698.aspx 
 

The RDS Host VM is now complete.  Conduct a pre-test (Section 4) to validate the setup before creating 
a Farm and RDS Desktop Pool in Horizon.  Also, see next section for different ways to launch sessions. 
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Different launch scenarios:         

The table below illustrates the different ways to launch a test. 

Type of Launch Session 
Launch 
Delay 

Process 
(50 Test Users/Sessions per Session 
Launcher VM) 

Result 

Start one launcher at 
a time 

30 Log into Launcher A 
Wait 25 minutes *  
Log into Launcher B 
Wait 25 minutes   
Log into Launcher C 
Wait 25 minutes  
Log into Launcher D 

Sessions launch every 30 
seconds for 100 minutes 

Stagger start four 
launchers 

60 Log into Launcher A1 
Wait 15 seconds 
Log into Launcher A2 
Wait 15 seconds 
Log into Launcher A3 
Wait 15 seconds 
Log into Launcher A4 

Sessions launch every 15 
seconds for 50 minutes 

Hybrid stagger start 60 Log into Launcher A1 
Wait 20 seconds  
Log into Launcher A2 
Wait 20 seconds 
Log into Launcher A3 
Wait 50 minutes 
Change Session Launcher Delay to 30 
Log into Launcher A4 

Sessions launch every 20 
seconds for 50 minutes 
then last 50 sessions 
launch every 30 seconds 
for 25 minutes 

 
Example:  200 VDI Desktops or Sessions with 30 seconds between launches 

1. Number of Session Launchers:   200 VMs / 50 sessions per Launcher = 4 Session Launcher VMs 
2. Session Launch Delay:  4 Session Launcher VMs  x  30 seconds  =  120 seconds 
3. Total time to launch all sessions:   

# of VMs   x  time between session launches  =  total time to launch all sessions 
   200 VMs  x  30 second launch                           =  6000 seconds to launch all sessions   

              =  100 minutes or 1 hours, 40 minutes 

 

*Note that in this example the delay between logging into the Session Launcher VMs is 25 seconds.  This 
is done to have a steady flow of Users logging in. 
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Appendix E:  Configuration File Cheat Sheet 

Below is information about the configuration file for those who like to edit manually. 

Configuration File:  Config.Wkld.NA.txt      

 
Line  Value Description Comment or Valid Values 
1 Test Information Label  
2 VDI Testing Test name  
3 Testing Apps Test description  
4 NA Group name  
5 \Date\Errorlogs Error log path Log folder must exist prior to running the test 
6 \Date\Timinglogs Timing log path Log folder must exist prior to running the test 
7 Test Scenario Variables Label  
8 one Number of tests one or many 
9 start now Start test start now or start future 
10 07:00 Start time 24-hour clock 
11 logoff After test completes logon or logoff 
12 Test Variables Label  
13 10 # of VMs under test 10 or 64 or 250 or 500 
14 iteration Test type iteration or duration 
15 00 Test duration (milliseconds) If iteration, this line is 00 
16 3 # of iterations If duration, this line is 1000000 
17 random Application order random or static 
18 30000 Think time (milliseconds) Upper limit of random delay 
19 Outlook Variables Label  
20 0 Outlook Setup  
21 0 Outlook 1 = Run, 0 = Do not run 
22 1 # of emails +1  
23 @vdi-smtp2.rawc.local @domainname  
24 10.100.100.100 Incoming mail server (IMAP) IP Address or DNS name 
25 10.100.100.100 Outgoing mail server (SMTP) IP Address or DNS name 
26 vmware1 Password  
27 guest+4 Email format Multiple values* 
28 Gmail Variables Label  
29 0 Gmail Setup 1 =Run, 0 = Do not run 
30 0 Gmail 1 =Run, 0 = Do not run 
31 1 # of emails  
32 specificname Specific username of Gmail Acct  
33 specificname@gmail.com Gmail Email Address  
34 imap.gmail.com Incoming mail server (IMAP)  
35 smtp.gmail.com Outgoing mail server (SMTP)  
36 pswd Password  
37 specific Email format  
38 Office Variables Label  
39 1 MS Word Doc 1 1 = Run, 0 = Do not run 
40 Placeholder Placeholder  
41 5000 Typing speed (milliseconds) 5000 or 10000 or 15000 
42 0 Random Word Doc 1 = Run, 0 = Do not run 
43 10 # of Random words  
44 0 Excel 1 = Run, 0 = Do not run 
45 0 PowerPoint 1 = Run, 0 = Do not run 
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Line  Value Description Comment or Valid Values 
46 Browser Variables Label  
47 0 Internet Explorer 1 = Run, 0 = Do not run 
48 0 Chrome 1 = Run, 0 = Do not run 
49 0 Firefox 1 = Run, 0 = Do not run 
50 https://www.co.com/ Firefox URL to browse  
51 Adobe Reader Variables Label  
52 1 Adobe Reader PDF Browsing 1 = Run, 0 = Do not run 
53 6 # Pages to browse  
54 1 Adobe Reader PDF Scrolling 1 = Run, 0 = Do not run 
55 5 PDF Scrolling speed 1-9 (1-very slow, 5-medium, 9-very fast) 
56 45000 PDF Scrolling time (milliseconds)  
57 Video Variables –  Media Player Label   
58 0 Video #1 1 = Run, 0 = Do not run 
59 File_Name.wmv Video #1 Name  
60 120000 Video #1 duration (milliseconds)  
61 Placeholder Placeholder  
62 Placeholder Placeholder  
63 Placeholder Placeholder  
64 YouTube Variables Label  
65 0 YouTube Video #1 1 = Run, 0 = Do not run 
66 “http://www.youtube.com/w...” Video #1 URL Use “quotes” 
67 10000 Video #1 duration (milliseconds)  
68 Placeholder Placeholder   
69 Placeholder Placeholder   
70 Placeholder Placeholder   
71 Misc. App Variables Label  
72 0 7-Zip 1 = Run, 0 = Do not run 
73 0 Photos 1 = Run, 0 = Do not run 
74 Placeholder Placeholder  
75 0 Notepad 1 = Run, 0 = Do not run 
76 0 Sleep 1 = Run, 0 = Do not run 
77 4500 Sleep duration (milliseconds)  
78 Copy Variables Label  
79 0 File Copy1 – Network Share to 

User\Documents\FilesCopied 
1 = Run, 0 = Do not run 

80 RAWC_Copy_Files File Copy 1 Source Specify Directory on RAWC Controller 
81 Hard coded  File Copy 1 Destination Hardcoded to 

C:\Users\$user\Documents\FilesCopied 
82 Placeholder Placeholder  
83 Placeholder Placeholder  
84 Placeholder Placeholder  

 
 
Line 27 – Email Format for Sendmail server 

 Valid values for use with the Sendmail server:   
o guest+4, guest+3+4, guest+2+3+4, guest+1+2+3+4 

 Examples of guest+# if the IP address is 10.123.45.199 
 guest+4(guest_4th octet) = guest199 
 guest+3+4 = guest45199 
 guest+2+3+4 = guest12345199 
 guest+1+2+3+4 = guest1012345199 

o username 
 Examples of username  
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 testuserxxx 
 tuxxx 
 userxxx 

 
o Make sure the email accounts in the Sendmail server are lower case and there are no 

hyphens or dashes.  The Sendmail server does not like capitalization or dashes in the 
account/username.  RAWC will change all capital letters to lowercase and remove any 
hyphens or dashes during the Outlook Setup function.  
 

Line 37 – Email format for Gmail account 
 Valid value for use with a specific Gmail account: 

o specific 
 Complete lines 32 and 33 with the specific username and full email account 

name.  These values will be used during Outlook Setup and the sending and 
receiving of real email. 

 
Lines 66 – YouTube Video 

 Be sure to use “quotes”.  
o “https://www.youtube.com/watch?v=qFpr6lMLg00” 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



60 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
VMware, Inc. 3401 Hillview Avenue Palo Alto CA 94304 USA Tel 877-486-9273 Fax 650-427-5001 www.vmware.com 

Copyright 2019 VMware, Inc. All rights reserved.  This product is protected by U.S. and international copyright and intellectual property laws.  
VMware products are covered by one or more patents listed at http://www.vmware.com/go/patents.  VMware is a registered trademark or 
trademark of VMware, Inc. in the United States and/or other jurisdictions. All other marks and names mentioned herein may be trademarks of 
their respective companies. 

 


